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Part 1 
Introduction 
! When you create a character set, the two times 26 letters "A" to "Z" and "a" to 
"z" are not enough. Because in addition to the basic letters, there are many 
European special characters. Just think of the German letters "Ä, ä, Ö, ö, Ü, ü, ẞ, ß and 
ſ" (more on this below). Europe's diversity is also reflected in the more than 40 
languages, from Albanian to Welsh, that use Latin letters for writing. In order for users 
of your character set to be able to write in all of these languages without any 
problems, that is why it needs almost 200 special characters. This sounds a lot, but 
it is not so bad. Firstly, most of these letters are derived from the basic letters and are 
only distinguished by an additional character that is placed above or below the letter, 
as in "ä, á, à, ç". And secondly, there are very few special letters. 

Additional characters or diacritical marks 
The additional characters are also called diacritical marks or diacritics (Greek 
διακρίνειν diakrinein, "to distinguish"). There are dots, dashes, ticks, arcs or circles, 
which are usually above the letter, but can also be below it or even go through the 
letter. In German, for example, we have two dots that make our umlauts "ä, ö, ü" 
recognisable. The diacritics are used to indicate a different pronunciation or stress. The 
advantage of the additional characters is that no separate letters had to be invented 
for this task, and yet they expand the alphabet of a language. 

Nineteen diacritical marks 
While the following new ten diacritical marks are found in European languages. 
However, there are more worldwide. Consequently, to expand the basic alphabet, you 
only need to create these nineteen characters and combine them with the basic 
letters to create all the necessary European special characters. So you see, the work is 
done faster than the almost 200 special characters that appear would suggest. So you 
need: 
• Akut (as in é):  ́
• Breve (as in ă or ḫ): ˘ 
• Cédille (as in ç or ģ):  ̧or  ̒
• Double Acute (as in ő) und Double Gravis (as in ȁ):  ̋and  ̏
• Gravis (wie in è):  ̀
• Hatschek or Caron (as in č, ř, š, ž):  ̌
• Horn (as in ơ): ̛ 
• subscript Komma (as in ș, ț):  ̦
• Ring (as in å):  ̊
• Makron (as in ā):  ̄
• Middle point (as in Ŀ): · 
• Ogonek (as in ę):  ̨
• Point below (as in ḍ, ṭ) and above (as in ż):  ̣and  ̇
• Slash (as in ø, ł):   ̷
• Tilde (as in ñ):  ̃
• Trema (as in ä, ë, ö, ü):  ̈
• Circumflex (as in â, ê, î): ^ 
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Summary of the additional signs 
If you display the 19 diacritical marks for European special characters alone, they 
look like this. So you can use this list as a template for your own character set. 

•   ̈¯  ́˘  ̧ ̒ ̋ ̏ ̀ ̌ ̦ ̊·  ̨ ̣˙   ̷ ̃ˆ 

Stand-alone special characters (special letters) 
In addition to the diacritical marks, there are also independent letters that 
complement the alphabet of a language. These special letters usually only exist in 
one language. European special characters also contain these special letters. Often, 
these forms were created in the course of time by writing two letters together 
(ligature). For example, the German letter "ß" was created from the long "ſ" (s) and 
short "s". In the meantime, the ß also exists as a capital letter. - On the other hand, 
there were also backward developments, as with the "þ" (Thorn), which was replaced 
by the letters "th" in English from the 14th century onwards, but was written more as 
a "y". This is why you find names for pubs like "ye old" and speak it like "the old". - 
Today there are the following twelve independent letters in European languages:  

• Æ æ ð Ĳ ĳ Œ œ ſ ẞ ß Þ þ. 

Graphic variant 
Graphical or allographic variant are letters that have the same function in an 
alphabet, but look different. - Allograph goes back to the ancient Greek ἄλλος allos 
(different, different) and γραφή graphé (writing)..  

German has two lower-case s letters, the long "ſ" (at the beginning and middle of the 
syllable) and the short "s" (at the end of the syllable). The "ſ" (but please do not 
confuse it with "f") is only a graphic positional variant. By the way, according to 
current spelling, it is still allowed to use it in German. There are also other allographic 
variants such as the letters "a" and "ɑ". They also exist for other letters/characters 
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such as "f", "ß" or "&". When reading, you will most often encounter these variants in 
serif fonts, written either normally or in italics. Finally, in OpenTypFonts (.otf), the 
variants are called alternatives and are marked with ".alt" when the font is created. 

Diacritical marks and special letters by language 
The European special characters in the form of diacritical marks and special letters in 
European and related languages are distributed as follows: 

• Afrikaans: Á, á, Ä, ä, É, é, Ë, ë, Ê, ê, Í, í, Ï, ï, Ó, ó, Ö, ö, Ô, ô, Ú, ú, Ü, ü, Ű, ű, Ý, ý 
• Albanian: Ç, ç, Ë, ë 
• Bosnian: Ć, ć, Č, č, Đ, đ, Š, š, Ž, ž 
• Breton: Ê, ê, Ñ, ñ, Ù, ù 
• Danish: Å, å, Æ, æ, Ø, ø 
• German: Ä, ä, Ö, ö, ẞ, ß, Ü, ü, ſ 
• Esperanto: Ĉ, ĉ, Ĝ, ĝ, Ĥ, ĥ, Ĵ, ĵ, Ŝ, ŝ, Ŭ, ŭ 
• Estonian: Ä, ä, Č, č, Ő, ő, Ö, ö, Š, š, Ü, ü, Ž, ž 
• Faroese: Á, á, Æ, æ, Ð, ð, Í, í, Ó, ó, Ø, ø, Ú, ú, Ý, ý 
• Finnish: Ä, ä, Å, å, Ö, ö 
• French: À, à, Á, á, Â, â, Æ, æ, Ç, ç, È, è, É, é, Ê, ê, Ë, ë, Î, î, Ï, ï, Ô, ô, Œ, œ, Ù, ù, Ű, ű, 

Ÿ, ÿ 
• Frisian: Â, â, Ű, ű 
• Gaelic: Á, á, É, é, Í, í, Ó, ó, Ú, ú 
• Greenlandic: Ĩ, ĩ, ĸ, Ũ, ũ 
• Hawaiian: Ā, ā, Ē, ē, Ī, ī, Ō, ō, Ū, ū 
• Icelandic: Á, á, Æ, æ, Ð, ð, É, é, Í, í, Ó, ó, Ö, ö, Ú, ú, Ý, ý, Þ, þ 
• Italian: À, à, È, è, É, é, Ì, ì, Í, í, Ï, ï, Ò, ò, Ó, ó, Ù, ù, Ú, ú 
• Catalan: À, à, Ç, ç, È, è, É, é, Í, í, Ï, ï, Ŀ, ŀ, Ò, ò, Ó, ó, Ú, ú, Ü, ü, ª, º 
• Croatian: Ć, ć, Č, č, Đ, đ, Š, š, Ž, ž 
• Latvian: Ā, ā, Č, č, Ē, ē, Ģ, ģ, Ī, ī, Ķ, ķ, Ļ, ļ, Ņ, ņ, Ō, ō, Ŗ, ŗ, Š, š, Ū, ū, Ž, ž 
• Lithuanian: Ą, ą, Č, č, Ė, ė, Ę, ę, Į, į, Š, š, Ū, ū, Ų, ų 
• Livisch: Ä, ä, Ǟ, ǟ, Ā, ā, Č, č, Ḑ, ḑ, Ē, ē, Ģ, ģ, Ī, ī, Ķ, ķ, Ļ, ļ, Ņ, ņ, Ö, ö, Ȫ, ȫ, Ō, ō, Ő, ő, 
Ȭ, ȭ, Ọ, ọ, Ȯ, ȯ, Ŗ, ŗ, Š, š, Ț, ț, Ü, ü, Ū, ū, Ȳ, ȳ, Ž, ž 

• Luxembourgish: Ä, ä, É, é, Ë, ë, Ü, ü 
• Maltese: Ċ, ċ, Ġ, ġ, Ħ, ħ, Ż, ż 
• Molwani: Ç, ç, Î, î, Š, š, Ṣ, ṣ 
• Dutch: É, é, Ë, ë, Ï, ï, Ĳ, ĳ, Ó, ó, Ÿ, ÿ 
• Norwegian: Å, å, Æ, æ, Ø, ø 
• Polish: Ą, ą, Ć, ć, Ę, ę, Ł, ł, Ń, ń, Ó, ó, Ś, ś, Ź, ź, Ż, ż 
• Portuguese: Â, â, Ã, ã, Ç, ç, Ê, ê, Ó, ó, Ô, ô, Ő, ő, Ü, ü 
• Rhaeto-Romanic: É, é, È, è, Ê, ê, Ï, ï, Ö, ö, Ü, ü 
• Romanian: Â, â, Ă, ă, Î, î, Ş, ş, Ș, ș, Ţ, ţ, Ț, ț 
• Russisch (lateinische Transkription): č, č, Ė, ė, Ë, ë, Ï, ï, Š, š, ž, ž 
• Samisch: Á, á, Č, č, Đ, đ, Ŋ, ŋ, Š, š, š, Ŧ, ŧ, Ǫ, ǫ, Ž, ž 
• Schwedisch: Å, å, Ä, ä, Ö, ö 
• Serbisch: Ć, ć, Č, č, Đ, đ, Š, š, Ž, ž 
• Slowakisch: Á, á, Ä, Ä, ä, Č, č, Ď, ď, É, é, Í, í, Ĺ, ĺ, Ľ, ľ, Ň, ň, Ó, ó, Ô, ô, Ô, Ŕ, ŕ, Š, š, Ť, ť, 

Ú, ú, ú, Ý, Ý, ý, Ž, ž 
• Slowenisch: Č, č, Š, š, š, Ž, ž 
• Sorbisch (Wendisch): Ć, ć, Č, č, Ě, ě, Ł, ł, Ń, ń, Ó, ó, Ž, ž, Ź, ź 
• Spanish (Castellano), Á, á, ç, É, é, Í, í, Ñ, ñ, Ó, ó, Ú, ú, Ü, ü, ª, º 
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• Czech: Á, á, Č, č, Ď, ď, É, é, Ě, ě, Í, í, Ň, ň, Ó, ó, Ó, ó, Ř, ř, Ť, ť, Ú, ú, Ů, ů, Ý, ý, Ž, ž 
• Turkish: Â, â, Ç, ç, Ğ, ğ, İ, i, I, ı, Î, î, Ö, ö, Ô, ô, Ş, ş, Ü, ü, Ű, ű 
• Hungarian: Á, á, É, é, Í, í, Ó, ó, Ö, ö, Ő, ő, Ú, ú, Ü, ü, Ű, ű 
• Welsh: Â, â, Ŵ, ŵ, Ŷ, ŷ 

Summary of the characters 
The European special characters in the form of the 198 diacritical marks and 
special letters, each separated by a space, look like this. You can use this list as a 
template for your own European character set. 

• Á á Ă ă Â â Å å Ä ä Ǟ ǟ Ã ã Ą ą Ā ā Æ æ Ć ć Ĉ ĉ Ċ ċ Ç ç Ď ď Ḑ ḑ Đ đ Ð ð É é Ê ê Ě ě Ë ë 
Ė ė Ę ę Ē ē Ğ ğ Ĝ ĝ Ġ ġ Ģ ģ Ĥ ĥ Ħ ħ İ ı Í í Ì ì Î î Ï ï Ĩ ĩ Į į Ī ī Ĳ ĳ Ĵ ĵ Ķ ķ Ĺ ĺ Ļ ļ Ł ł Ŀ ŀ Ń ń Ň ň 
Ñ ñ Ņ ņ Ŋ ŋ Ó ó Ò ò Ô ô Ö ö Ȫ ȫ Ő ő Õ õ Ȯ ȯ Ø ø Ǫ ǫ Ō ō Ọ ọ Œ œ ĸ Ř ř Ŕ ŕ Ŗ ŗ ſ Ś ś Ŝ 
ŝ Š š Ş ş Ṣ ṣ Ș ș ẞ ß Ť ť Ţ ţ Ț ț Ŧ ŧ Ú ú Ù ù Ŭ ŭ Û û Ů ů Ü ü Ű ű Ũ ũ Ų ų Ū ū Ŵ ŵ Ý ý Ŷ ŷ 
Ÿ ÿ Ȳ ȳ Ź ź Ž ž Ż ż Þ þ ª º 

Conclusion 
Creating a character set with European special characters that can be used by 
all Europeans in their languages requires some effort for the numerous diacritical 
characters and special letters. 

www.computergrafik-know-how.de About European special characters Page  of 5 24

http://www.computergrafik-know-how.de


Part 2 
! The second article, "European Special Characters (2)", deals with entering 
these characters on the keyboard. As always, the motto is "From zero to ...". 
Because there are different ways to reach the goal and they are also different for Mac 
users and Windows users, you will find several descriptions. In contrast, in the first 
article "European Special Characters" (see above) I showed how diverse the alphabets 
of the European languages that write in Latin letters are. 

Prerequisite the correct character set 
In order to be able to write the nineteen diacritical characters  
• ̈ ¯  ́˘  ̧ ̒ ̋ ̏ ̀ ̌ ̦ ̊·  ̨ ̣˙   ̷ ̃ˆ 
and the twelve special letters 
• Æ æ ð Ĳ ĳ Œ œ ſ ẞ ß Þ þ 
the character set you want to use must also contain them. Unfortunately, this is not a 
matter of course, because many font designers shy away from the effort of including 
the necessary characters in their character set. The necessary 198 letters look like 
this, as described in the first article: 
• Á á Ă ă Â â Å å Ä ä Ǟ ǟ Ã ã Ą ą Ā ā Æ æ Ć ć Ĉ ĉ Ċ ċ Ç ç Ď ď Ḑ ḑ Đ đ Ð ð É é Ê ê Ě ě Ë ë 
Ė ė Ę ę Ē ē Ğ ğ Ĝ ĝ Ġ ġ Ģ ģ Ĥ ĥ Ħ ħ İ ı Í í Ì ì Î î Ï ï Ĩ ĩ Į į Ī ī Ĳ ĳ Ĵ ĵ Ķ ķ Ĺ ĺ Ļ ļ Ł ł Ŀ ŀ Ń ń Ň ň 
Ñ ñ Ņ ņ Ŋ ŋ Ó ó Ò ò Ô ô Ö ö Ȫ ȫ Ő ő Õ õ Ȯ ȯ Ø ø Ǫ ǫ Ō ō Ọ ọ Œ œ ĸ Ř ř Ŕ ŕ Ŗ ŗ ſ Ś ś Ŝ 
ŝ Š š Ş ş Ṣ ṣ Ș ș ẞ ß Ť ť Ţ ţ Ț ț Ŧ ŧ Ú ú Ù ù Ŭ ŭ Û û Ů ů Ü ü Ű ű Ũ ũ Ų ų Ū ū Ŵ ŵ Ý ý Ŷ ŷ 
Ÿ ÿ Ȳ ȳ Ź ź Ž ž Ż ż Þ þ ª º  

The following character sets can display all of these letters: Arial*, Adobe Source Serif 
4 (OFL), Adobe Source Sans Pro (OFL), Cambria*, DejaVu Sans (Public Domain), DejaVu 
Serif (Public Domain), Linux Biolinum O (GNU/GPL), Linux Libertine O (OFL), Helevtica*, 
Times* or New Roman Times*. It does not matter whether the font is TrueType (ttf) or 
OpenTypeFont (otf). 
(* = Fonts that are part of the macOS and/or Windows operating system. OFL = Open 
Font License) 
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" On most websites that offer downloadable fonts, there is a field where you can 
enter your own characters to see what they look like. Use this field to check if the 
desired characters are included in the font. You can simply copy some of the 204 
characters above from here into the field. On the Fonts2u website (see above) this 
looks like this for the Ubuntu font. As you can see, this font can also display the 
European special characters. If you see nothing, empty boxes or question marks 
instead, then stay away from this font. 

Input options for European special characters 
Once the correct character set has been installed and selected as the writing font, the 
question arises: Which is the "correct" input option? - Answer: That depends. 

" If all you need for a concert programme is a name like that of the Roman composer 
Antonín Dvořák, the quickest way is to enter the name on wikipedia and copy it into 
your text in the correct spelling. (Long live copy-paste! And no, this is not copyright 
infringement). 

If you have to deal with longer texts or repeatedly use foreign words or names, you 
can enter the special characters with .... 

• a real keyboard 
• the on-screen keyboard under macOS and Windows 10 
• the glyph window 

Input options via real keyboard 
Special characters of a foreign language can only be typed if you know the 
corresponding key on the keyboard. Under the macOS, you can reach many European 
special characters via the <alt> and <alt><shift> keys. Under Windows, you must 
first install the appropriate language(s). The alternative to this and the quicker way for 
a few special characters are the glyph windows. Also, in MS Word you can insert 
special characters into a text using the <alt> key and numbers. 

Input options via on-screen keyboard 

Under macOS 
To see the on-screen keyboard in macOS (10.14 or higher), you must first activate it. 
A Go to the system settings and click on Keyboard. 
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B Then activate the tick "Show keyboard overview ... in the menu bar" under 
"Keyboard". 

 

If you would like to have a different keyboard layout instead of the German one, 
then ... 
C Click on the small plus symbol under "Input sources" and then select the desired 
language. 
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The symbol for the keyboard or a flag for the selected language then appears at the 
top of the menu bar. 
D Go with the mouse to the symbol of the keyboard or the flag and select the menu 
item "Show keyboard overview". 

 

E Now press the Shift and/or Option key and you will see the symbols that can then 
be called up. Either by key or by mouse click you can then insert this symbol into your 
text. 

www.computergrafik-know-how.de About European special characters Page  of 9 24

http://www.computergrafik-know-how.de


 

Under Windows 10 
To call up the on-screen keyboard under Windows 10, proceed as follows: 
A In the Start menu, call ... 
B to open the programme "On-screen keyboard" under "Ease of use". 
C It then appears the on-screen keyboard. 

 

In order to call up another language, it must first be installed, if it has not already been 
installed. 
D Go to the Start menu and call up the settings. 
E Click on "Time and language". 
F Click on "Language" and ... 
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G under "Preferred languages" on the plus symbol. 
H In the following window you will see all the languages available in Windows. To 
narrow down the selection, enter the first letters of the desired language in the search 
field. Here "Dans" for Dansk (Danish). 
I Click the desired language, here "Dansk". 
J Now click on "Next". 
K In the next window you will see the selected language, here "Dansk". 
L Only activate the tick for "Install language pack". You do not need the rest for the 
keyboard and it only takes up unnecessary space on your hard disk. 
M Finally, click on "Install". 

 

N As soon as a second language has been installed, you will see the abbreviation 
(currently "DEU") for the current language in the task bar. If you click on it with the 
mouse, the selection of installed languages appears. 
O To switch to another language, click on the desired one. 
P If the on-screen keyboard is no longer visible: You can call up the "on-screen 
keyboard" again via Start menu > Ease of use. You can also fix it in the taskbar with a 
right mouse click. 
Q The on-screen keyboard changes layout with the selected language. This way you 
can easily find the special characters of a language and "type" them with a mouse 
click. 
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Glyphen-Fenster als Eingabemöglichkeit 
A glyph (Greek VS€WX glyph‹, German Eingeritztes) is the graphic representation of 
characters. In many programmes, including the following layout programmes and 
writing programmes, you can call up an overview that shows you all the glyphs 
contained in the selected character set. If you then click on one of these symbols, it 
will be inserted into your text. This procedure is slow and therefore only makes sense 
for really rarely needed special characters. 
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• Illustrator: Font > Glyphs 
• InDesign: Font > Glyphs 
• Photoshop: Window > Glyphs 
• Affinity Publisher: Text > Show Glyph Browser 
• Apple Pages: hold down the basic letter, e.g. the "A" and then Ä, Á, À and so on 

appear. However, this only works for the language set in the keyboard. 
• Libre Office: Insert > Special Characters 
• MS Word: Insert > Extended Symbol 
• OpenOffice: Insert > Special Characters 
• Papyrus: Text > Character overview 
• QuarkXpress: Window > Glyphs 
• Scribus: Insert > Character (click on "Extended Character Palette") 
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Part 3 
From ASCII to Unicode 
! The third article, "European Special Characters (3)", is about the Unicodes and 
their HTML entities. As always under the motto "From zero to ...", I present the 
Unicodes and the HTML entities here. This is something for technically interested 
"gourmets". 

At the end of the article you will find the table of all 198 European diacritical 
marks and special characters, which should help font designers in particular to 
create the necessary characters in their character set. 

ASCII-7 was the beginning 
ASCII-7 stands for "American Standard Code for Information Interchange" in 7-
bit coding. From 1963 onwards, 27 = 128 characters could be encoded, including 33 
non-printable and 95 printable characters. From the Latin alphabet, these were the 
lower-case letters "a" to "z" and the upper-case letters "A" to "Z", as well as the digits 
"0" to "9" and (mathematical) special characters such as brackets and punctuation 
marks. 

ASCII-8 with international characters 
With the spread of personal computers (PCs) by Apple, Arari, Commodore, IBM and 
others, the desire for national characters from European countries grew. From 1981, 
this became possible with the introduction of ASCII-8 in 8-bit encoding. IBM offered 
18 different encodings that also included non-Latin characters. 

Unicode – Zeichen für alle 
In 1991, Unicode 1.0 was introduced, which first included European, Middle Eastern 
and Indian scripts. Later, numerous other alphabets were added. In the meantime, 
many mathematical and other characters have been added, as well as currency signs 
and emojis. Each character in Unicode has its own number, which is assigned to the 
letter (glyph) during font design. Theoretically, 1,114,112 different characters can 
be encoded with it. There are two important UTF encoding methods: UTF-8 and 
UTF-16. 
UTF-8 is based on an 8-bit system in which the first 128 characters are identical to the 
original ASCII. 
UTF-16 is based on a 16-bit system and allows the representation of characters in one 
or two 16-bits. The last two are necessary to encode the German umlauts. 
U+xxxx In this way, every Unicode character can be described. The four "xxxx" stand 
for the hexadecimal numbers from "0000" to "FFFF". The small German "ß" has the 
number "U+00DF". Beyond UTF-8, the numbers after the "U+" can also have six digits. 

Unicode in HTML und HTML-Entitäten 
HTML (Hypertext Markup Language) is the markup language in which Internet 
pages are programmed. The Unicode characters can also be displayed in HTML. 
Instead of "U+", the representation begins with "&#x" followed by four hexadecimal 
numbers: "&#x0000;" to "&#xFFFF;". There is also the decimal notation without the 
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"x" and followed by decimal digits. Thus, the "ß" is hexadecimal "&#x00DF;" or 
decimal "&#223;". The HTML notation "&#...;" ending with a semicolon is called a 
numeric HTML entity. Every Unicode character can be described with a numeric 
HTML entity. 

As a further notation in HTML, there are also the named HTML entities. Instead of a 
number, they have an abbreviation that describes the character. For example, the "ß" 
as an HTML entity is "&ahead;". However, not every Unicode character has such an 
HTML entity. The German long S "ſ" Unicode "U+017F" or HTML "&#383;" or "&#x17F" 
has none. - Why? Ask the W3C :-) 

European special characters in Unicode and as HTML 
entities 
The 19 diacritical characters alone, which are mainly needed for the font design, look 
like this: 

Name Unicode dec. HTML hex. HTML named HTML

̈ U+00A8; &#168; &#xA8; &uml;

¯ U+00AF; &#175; &#xAF; &macr;

́ U+00B4; &#180; &#xB4; &DiacriticalAcute;

˘ U+02D8; &#728; &#x2D8; &breve;

̧ U+00B8; &#184; &#xB8; &Cedilla;

̒ U+031B; &#795; &#x31B; ./.

̋ U+02DD; &#733; &#x2DD; &DiacriticalDoubleAcute;

̏ U+030F; &#783; &#x30F; &DiacriticalDoubleGrave;

̀ U+0060; &#96; &#x60; &DiacriticalGrave;

̌ U+02C7; &#711; &#x2C7; &caron;

̦ U+02DB; &#731; &#x2DB; &ogon;

̊ U+02DA; &#730; &#x2DA; &ring;

· U+00B7; &#183; &#xB7; &CenterDot;

̨ U+0328; &#808; &#x328; ./.

̣ U+0323; &#803; &#x323; ./.

˙ U+02D9; &#729; &#x2D9; &DiacriticalDot;
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All 198 special characters used in European languages. 

̷ U+0337; &#823; &#x337; ./.

̃ U+02DC; &#732; &#x2DC; &DiacriticalTilde;

ˆ U+02C6; &#710; &#x2C6; &circ;

Name Unicode dec. HTML hex. HTML named HTML

Á U+00C1; &#193; &#xC1; &Aacute;

á U+00E1; &#225; &#xE1; &aacute;

Ă U+0102; &#258; &#x102; &Abreve;

ă U+0103; &#259; &#x103; &abreve;

Â U+00C2; &#194; &#xC2; &Acirc;

â U+00E2; &#226; &#xE2; &acirc;

Å U+00C5; &#197; &#xC5; &Aring;

å U+00E5; &#229; &#xE5; &aring;

Ä U+00C4; &#196; &#xC4; &Auml;

ä U+00E4; &#228; &#xE4; &auml;

Ǟ U+01DE; &#478; &#x1DE; ./.

ǟ U+01DF; &#479; &#x1DF; ./.

Ã U+00C3; &#195; &#xC3; &Atilde;

ã U+00E3; &#227; &#xE3; &atilde;

Ą U+0104; &#260; &#x104; &Aogon;

ą U+0105; &#261; &#x105; &aogon;

Ā U+0100; &#256; &#x100; &Amacr;

ā U+0101; &#257; &#x101; &amacr;

Æ U+00C6; &#198; &#xC6; &AElig;
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æ U+00E6; &#230; &#xE6; &aElig;

Ć U+0106; &#262; &#x106; &Cacute;

ć U+0107; &#263; &#x107; &cacute;

Ĉ U+0108; &#264; &#x108; &Ccirc;

ĉ U+0109; &#265; &#x109; &ccirc;

Ċ U+010A; &#266; &#x10A; &Cdot;

ċ U+010B; &#267; &#x10B; &cdot;

Ç U+00C7; &#199; &#xC7; &Ccedil;

ç U+00E7; &#231; &#xE7; &ccedil;

Ď U+010E; &#270; &#x10E; &Dcaron;

ď U+010F; &#271; &#x10F; &dcaron;

Ḑ U+1E10; &#7696; &#x1E10; ./.

ḑ U+1E11; &#7697; &#x1E11; ./.

Đ U+0110; &#272; &#x110; &Dstrok;

đ U+0111; &#273; &#x111; &dstrok;

Ð U+00D0; &#208; &#xD0; &ETH;

ð U+00F0; &#240; &#xF0; &eth;

É U+00C9; &#201; &#xC9; &Eacute;

é U+00E9; &#233; &#xE9; &eacute;

Ê U+00CA; &#202; &#xCA; &Ecirc;

ê U+00EA; &#234; &#xEA; &ecirc;

Ě U+011A; &#282; &#x11A; &Ecaron;

ě U+011B; &#283; &#x11B; &ecaron;

Ë U+00CB; &#203; &#xCB; &Euml;

ë U+00EB; &#235; &#xEB; &euml;
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Ė U+0116; &#278; &#x116; &Edot;

ė U+0117; &#279; &#x117; &edot;

Ę U+0118; &#280; &#x118; &Eogon;

ę U+0119; &#281; &#x119; &eogon;

Ē U+0112; &#274; &#x112; &Emacr;

ē U+0113; &#275; &#x113; &emacr;

Ğ U+011E; &#286; &#x11E; &Gbreve;

ğ U+011F; &#287; &#x11F; &gbreve;

Ĝ U+011C; &#284; &#x11C; &Gcirc;

ĝ U+011D; &#285; &#x11D; &gcirc;

Ġ U+0120; &#288; &#x120; &Gdot;

ġ U+0121; &#289; &#x121; &gdot;

Ģ U+0122; &#290; &#x122; &Gcedil;

ģ U+0123; &#291; &#x123; &gcedil;

Ĥ U+0124; &#292; &#x124; &Hcirc;

ĥ U+0125; &#293; &#x125; &hcirc;

Ħ U+0126; &#294; &#x126; &Hstrok;

ħ U+0127; &#295; &#x127; &hstrok;

İ U+0130; &#304; &#x130; &Idot;

ı U+0131; &#305; &#x131; &inodot;

Í U+00CD; &#205; &#xCD; &Iacute;

í U+00ED; &#237; &#xED; &iacute;

Ì U+00CC; &#204; &#xCC; &Igrave;

ì U+00EC; &#236; &#xEC; &igrave;

Î U+00CE; &#206; &#xCE; &Icirc;
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î U+00EE; &#238; &#xEE; &icirc;

Ï U+00CF; &#207; &#xCF; &Iuml;

ï U+00EF; &#239; &#xEF; &iuml;

Ĩ U+0128; &#296; &#x128; &Itilde;

ĩ U+0129; &#297; &#x129; &itilde;

Į U+012E; &#302; &#x12E; &Iogon;

į U+012F; &#303; &#x12F; &iogon;

Ī U+012A; &#298; &#x12A; &Imacr;

ī U+012B; &#299; &#x12B; &imacr;

Ĳ U+0132; &#306; &#x132; &IJlig;

ĳ U+0133; &#307; &#x133; &ijlig;

Ĵ U+0134; &#308; &#x134; &Jcirc;

ĵ U+0135; &#309; &#x135; &jcirc;

Ķ U+0136; &#310; &#x136; &Kcedil;

ķ U+0137; &#311; &#x137; &kcedil;

Ĺ U+0139; &#313; &#x139; &Lacute;

ĺ U+013A; &#314; &#x13A; &lacute;

Ļ U+013B; &#315; &#x13B; &Lcedil;

ļ U+013C; &#316; &#x13C; &lcedil;

Ł U+0141; &#321; &#x141; &Lstrok;

ł U+0142; &#322; &#x142; &lstrok;

Ŀ U+013F; &#319; &#x13F; &Lmidot;

ŀ U+0140; &#320; &#x140; &lmidot;

Ń U+0143; &#323; &#x143; &Nacute;

ń U+0144; &#324; &#x144; &nacute;
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Ň U+0147; &#327; &#x147; &Ncaron;

ň U+0148; &#328; &#x148; &ncaron;

Ñ U+00D1; &#209; &#xD1; &Ntilde;

ñ U+00F1; &#241; &#xF1; &ntilde;

Ņ U+0145; &#325; &#x145; &Ncedil;

ņ U+0146; &#326; &#x146; &ncedil;

Ŋ U+014A; &#330; &#x14A; &ENG;

ŋ U+014B; &#331; &#x14B; &eng;

Ó U+00D3; &#211; &#xD3; &Oacute;

ó U+00F3; &#243; &#xF3; &oacute;

Ò U+00D2; &#210; &#xD2; &Ograve;

ò U+00F2; &#242; &#xF2; &ograve;

Ô U+00D4; &#212; &#xD4; &Ocirc;

ô U+00F4; &#244; &#xF4; &ocirc;

Ö U+00D6; &#214; &#xD6; &Ouml;

ö U+00F6; &#246; &#xF6; &ouml;

Ȫ U+022A; &#554; &#x22A; ./.

ȫ U+022B; &#555; &#x22B; ./.

Ő U+0150; &#336; &#x150; &Odblac;

ő U+0151; &#337; &#x151; &odblac;

Õ U+00D5; &#213; &#xD5; &Otilde;

õ U+00F5; &#245; &#xF5; &otilde;

Ȯ U+022E; &#558; &#x22E; ./.

ȯ U+022F; &#559; &#x22F; ./.

Ø U+00D8; &#216; &#xD8; &Oslash;
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ø U+00F8; &#248; &#xF8; &oslash;

Ǫ U+01EA; &#490; &#x1EA; ./.

ǫ U+01EB; &#491; &#x1EB; ./.

Ō U+014C; &#332; &#x14C; &Omacr;

ō U+014D; &#333; &#x14D; &omacr;

Ọ U+1ECC; &#7884; &#x1ECC; ./.

ọ U+1ECD; &#7885; &#x1ECD; ./.

Œ U+0152; &#338; &#x152; &OElig;

œ U+0153; &#339; &#x153; &oelig;

ĸ U+0138; &#312; &#x138; &kgreen;

Ř U+0158; &#344; &#x158; &Rcaron;

ř U+0159; &#345; &#x159; &rcaron;

Ŕ U+0154; &#340; &#x154; &Racute;

ŕ U+0155; &#341; &#x155; &racute;

Ŗ U+0156; &#342; &#x156; &Rcedil;

ŗ U+0157; &#343; &#x157; &rcedil;

ſ U+017F; &#383; &#x17F; ./.

Ś U+015A; &#346; &#x15A; &Sacute;

ś U+015B; &#347; &#x15B; &sacute;

Ŝ U+015C; &#348; &#x15C; &Scirc;

ŝ U+015D; &#349; &#x15D; &scirc;

Š U+0160; &#352; &#x160; &Scaron;

š U+0161; &#353; &#x161; &scaron;

Ş U+015E; &#350; &#x15E; &Scedil;

ş U+015F; &#351; &#x15F; &scedil;
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Ṣ U+1E62; &#7778; &#x1E62; ./.

ṣ U+1E63; &#7779; &#x1E63; ./.

Ș U+0218; &#536; &#x218; ./.

ș U+0219; &#537; &#x219; ./.

ẞ U+1E9E; &#7838; &#x1E9E; ./.

ß U+00DF; &#223; &#xDF; &szlig;

Ť U+0164; &#356; &#x164; &Tcaron;

ť U+0165; &#357; &#x165; &tcaron;

Ţ U+0162; &#354; &#x162; &Tcedil;

ţ U+0163; &#355; &#x163; &tcedil;

Ț U+021A; &#538; &#x21A; ./.

ț U+021B; &#539; &#x21B; ./.

Ŧ U+0166; &#358; &#x166; &Tstrok;

ŧ U+0167; &#359; &#x167; &tstrok;

Ú U+00DA; &#218; &#xDA; &Uacute;

ú U+00FA; &#250; &#xFA; &uacute;

Ù U+00D9; &#217; &#xD9; &Ugrave;

ù U+00F9; &#249; &#xF9; &ugrave;

Ŭ U+016C; &#364; &#x16C; &Ubreve;

ŭ U+016D; &#365; &#x16D; &ubreve;

Û U+00DB; &#219; &#xDB; &Ucirc;

û U+00FB; &#251; &#xFB; &ucirc;

Ů U+016E; &#366; &#x16E; &Uring;

ů U+016F; &#367; &#x16F; &uring;

Ü U+00DC; &#220; &#xDC; &Uuml;
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ü U+00FC; &#252; &#xFC; &Uuuml;

Ű U+0170; &#368; &#x170; &Udblac;

ű U+0171; &#369; &#x171; &udblac;

Ũ U+0168; &#360; &#x168; &Utilde;

ũ U+0169; &#361; &#x169; &utilde;

Ų U+0172; &#370; &#x172; &Uogon;

ų U+0173; &#371; &#x173; &uogon;

Ū U+016A; &#362; &#x16A; &Umacr;

ū U+016B; &#363; &#x16B; &umacr;

Ŵ U+0174; &#372; &#x174; &Wcirc;

ŵ U+0175; &#373; &#x175; &wcirc;

Ý U+00DD; &#221; &#xDD; &Yacute;

ý U+00FD; &#253; &#xFD; &yacute;

Ŷ U+0176; &#374; &#x176; &Ycirc;

ŷ U+0177; &#375; &#x177; &ycirc;

Ÿ U+0178; &#376; &#x178; &Yuml;

ÿ U+00FF; &#255; &#xFF; &yuml;

Ȳ U+0232; &#562; &#x232; ./.

ȳ U+0233; &#563; &#x233; ./.

Ź U+0179; &#377; &#x179; &Zacute;

ź U+017A; &#378; &#x17A; &zacute;

Ž U+017D; &#381; &#x17D; &Zcaron;

ž U+017E; &#382; &#x17E; &zcaron;

Ż U+017B; &#379; &#x17B; &Zdot;

ż U+017C; &#380; &#x17C; &zdot;
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Now it's up to you!+
%QClick on the "Donate" link if you would like to support this document 
and the maintenance of my website with a small donation via PayPal. 

Colophon 
This document was created in Apple Pages. The texts are taken from the website 
www.computergrafik-know-how.de and are protected by copyright. Fonts used are 
DejaVu Sans (OFL) and VNA Symbol (a self-created OpenTypFont). Adobe Photoshop 
and Illustrator were used for the graphics. 

Version of the document: 1.0 of 11 July 2021.

Å U+00DE; &#222; &#xDE; &THORN;

Ç U+00FE; &#254; &#xFE; &thorn;

ª U+00AA; &#170; &#xAA; &ordf;

º U+00BA; &#186; &#xBA; &ordm;

www.computergrafik-know-how.de About European special characters Page  of 24 24

http://www.computergrafik-know-how.de
https://www.paypal.com/donate?hosted_button_id=WF22LR538WW8Y
http://www.computergrafik-know-how.de

	Part 1
	Introduction
	Additional characters or diacritical marks
	Stand-alone special characters (special letters)
	Graphic variant
	Diacritical marks and special letters by language
	Summary of the characters
	Conclusion

	Part 2
	Prerequisite the correct character set
	Input options for European special characters
	Input options via real keyboard
	Input options via on-screen keyboard

	Part 3
	From ASCII to Unicode
	Unicode in HTML und HTML-Entitäten
	European special characters in Unicode and as HTML entities




